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Manual
--------------------------------------------------------------------------------------------------------------------------

TOOL DESCRIPTIONS -
--------------------------------------------------------------------------------------------------------------------------

SS MONITOR:  (aka SS VIEWER)
------------------------------------------------------------------------
Sega Saturn Monitor is a downloader utility. It uses either 3D Editor or Map Editor to send
images to a TV monitor by way of Saturn CartDev.

3D EDITOR:
------------------------------------------------------------------------
Models can be positioned in 3 space on the PC using standard 3D tools. Models are
positioned on the TV monitor using the Saturn controller. 3D Editor may be used with or
without SS Monitor.

MAP EDITOR:
------------------------------------------------------------------------
Image files can be imported and assembled as 16x16 tiles to create Maps. Map Editor may be
used with or without SS Monitor. (256 color only)

INSTALL NOTES -
--------------------------------------------------------------------------------------------------------------------------

FROM THE DTS WEBSITE--THE ZIP FILES:
------------------------------------------------------------------------
The WGT_10J.ZIP file contains the Windows95 Graphic Tools and will extract into the
following 6 files: _inst32i.ex_, _setup.dll, _setup.lib, Setup.exe, Setup.ins, Sssdk.z, and
WGT_MAN.pdf (Win95 Graphic Tool Manual & Reference).  Also a SAMPLE directory is
included which contains sample files for the 3D Editor/Map Editor.

The SDKSGIJ.ZIP file contains the Windows95 Graphic Tool Converter (for SGI) and will
extract into the following sub directories: sssdk, \bin, \doc, \dso, and \sglinc

The SGL302J.ZIP file contains supercedes all previous versions of SGL and incorporates the
upgrades from version 2.10a to 3.00 (Library and Sample Programs).  New features in SGL
3.00: near-clipping, depth cueing, real time gouraud shading, and colored light source.

CAUTION (ZIP FILES):
------------------------------------------------------------------------
When unzipping any of the above files, be sure to use an expander like WinZip 6.0a that
preserves long file names. If a DOS expander is used it may truncate the file names and then
they won’t be found.
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FROM THE DTS CD--INSTALL NOTES:
--------------------------------------------------------------------------------------------------------------------------
The folder NOV96.DTS/GRAPHICS/TOOL_PC/WIN95 contains:
WGT_MAN.pdf, and folders; SDK_GT, SDK_SGI, jpg_sam, map_sam, sg3_sam.

Run SETUP.EXE in the SDK_GT folder to install the Windows95 Graphic Tools.

Run .INSTALL in the SDK_SGI folder to install the Windows95 Graphic Tool Converter for
the SGI.

OTHER SET-UP NOTES -
--------------------------------------------------------------------------------------------------------------------------
The SS-SDK also contains SGL 3.01, refer to the Programming Section for this.

CAUTION (ASPI FILES):
------------------------------------------------------------------------
If after installation SSMonitor does not send images to Saturn/CartDev, it may be necessary
to install:
   Adaptec EZ-SCSI ASPI Drivers
   (included with the Adaptec SCSI Master Card Kit #1542CF)

BASIC SET-UP:
------------------------------------------------------------------------
Before running the 3D Editor/Map Editor/Sega converter tools, run the tool SSMonitor -
this tool allows you to preview models and scroll screen data on your Saturn, you must
have a CartDev hooked to the PC to use this functionality.

- Turn on Saturn/CartDev and run SSMonitor.

If SSMonitor has initialized correctly you should see the SSMonitor program come up in
windows and the Saturn CartDev screen should be black with some text saying
SSViewer[v0.8] across the bottom.

If this doesn't happen after 15 seconds power down the CartDev and Saturn, kill the
SSMonitor task running in the background and repeat the process. Make sure the CartDev is
Rev B.

If for any reason you need to re-initialize the SSMonitor, use the Load SegaViewer option
(2nd button on toolbar) since this is the mode the other tools use for CartDev Saturn
preview.
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HOW TO USE...
--------------------------------------------------------------------------------------------------------------------------
To download to Saturn from either the 3D Editor or the Map Editor be sure to open SS
Monitor FIRST.

HOW TO USE SS MONITOR:
--------------------------------------------------------------------------------------------------------------------------
The SS Monitor does not have any functionality by itself. Images may be sent to Saturn by
either the 3D Editor or the Map Editor using the SS Monitor . The SS Monitor must be
opened first. Then images can be sent from within 3D Editor or Map Editor.

SS Monitor Modes and Control -
------------------------------------------------------------------------
By default, the SSMonitor is in OBJECT mode, the current mode is displayed in the bottom
left corner of the Saturn CartDev screen. There are a total of 3 modes currently; OBJECT,
SCROLL, and MOTION. (The Motion mode is not implemented yet). To cycle through the
modes, press the TOP-R button on the Player 1 D-PAD. To toggle the info screen, Press the
TOP-L button.
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HOW TO USE 3D EDITOR:
--------------------------------------------------------------------------------------------------------------------------
LOADING MODELS:
------------------------------------------------------------------------
- Load a SG3 file by selecting “Open...” from the “File” menu.
(Example models in SG3 format are provided in the “sg3_sam” folder).

3D Editor handles these MODEL file types:
   OPEN...   SG3
   SAVE...   SG3 , MDL
(See also 3D Editor Texture List Window file types listed below).

ORIENTING THE MODEL:
------------------------------------------------------------------------
The default model that appears is a cube. Only one of the six polygons (or faces) is in view at
first.

- Using three of the icons of the “Tool Box” palette, a model may be; Rotated, Translated or
Scaled. To re-set the view of the model choose a view from the “Camera” Icon’s pop-up
menu. To save custom view choose a “New Camera” from the “Options” menu.

SELECTING POLYGONS:
------------------------------------------------------------------------
- To select single or multiple polygons, in the “Model Window”, select the “Select Polygons”
icon (the green one) from the “Tool Box” and click on individual faces.

- To select all the polygons choose “Select All” from the “Edit” menu.

- To de-select polygons choose “Select Clear” from the “Edit” menu, (Hold down the
“Control” key to de-select specific polygons).

USING TEXTURES:
------------------------------------------------------------------------
- To view the “Texture List” window select “Texture List” from the “Window” menu.

- To access pre-assigned (SGT) textures for a model select “Open...” from the “Texture List”
window’s “File” menu.

Pre-assigned model/texture samples sets are in the folder “sg3_sam”;
   hover.sg3  &  hover.sgt
   monitor.sg3  &  monitor.sgt
   sonic3.sg3  &  sonic3.sgt
   terrain.sg3  &  terrain.sgt

- To access new (BMP or JPG) textures for a any model select “Import...” from the “Texture
List” window’s “File” menu.
(Hold down the “Shift” key to mouse select multiple files).
(Sample textures in BMP and JPG format are provided in the “jpg_sam” folder).
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- With a polygon(s) selected, double click on a texture in the “Texture List” window to apply
it to the model.

3D Editor handles these IMAGE file types (from the “Texture List” window):
   OPEN...   SGT
   SAVE...   SGT, TXR
   IMPORT...   BMP, JPG
   EXPORT...   BMP, SGL, TIF

Image files must be 256 color.

Image file dimension restrictions:
   Y size :   1 - 255 pixels in height
   X size :   multiple of 8 pixels in width
note: loading an invalid size may cause a crash.

DOWNLOADING TO SATURN (3D EDITOR):
------------------------------------------------------------------------
- Once the model and it’s textures are assembled in the “Model” window they can be sent to
the Saturn CartDev.

- From the “View” menu choose “Send Target” and select “Model”. (Be sure the SS Monitor
displays OBJECT mode on the TV screen).

- After a short pause the model should appear on the TV monitor.

- To update any changes to the texture assignments to the polygons, from the “View” menu
choose “Send Target” and select “Texture”.

- To update any changes to the background color or lighting, from the “View” menu choose
“Send Target” and select “Scene”.

Note: The orientation of the model on the TV may not match that of the PC’s “Model
Window”. To change the orientation of the model on the TV screen use the Saturn
controller.
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3D EDITOR CONTROLS:
--------------------------------------------------------------------------------------------------------------------------

OBJECT MODE - 3D Editor (VDP1)
Allows you to view a model loaded in 3D Editor and view it (Rotate, Translate, Scale), very
useful for checking sorting problems ,etc.

Controls:
   D - pad:             Rotate model
   A   button:        Hold and move D-pad to scale
   A   button:        Hold and move D-pad to translate
   C   button:         Hold and move D-pad to scale (fast)
   Z   button:         Hold and move D-pad to re-position model center
   Start button:     Reset/center model on-screen

DOWNLOAD TROUBLE-SHOOTING:
------------------------------------------------------------------------
When sending a model to the CartDev for preview, follow these steps to insure correct
viewing.

1) Download the texture - do this after importing or re-sizing any of the textures in the
texture list so any changes are correctly reflected in your models on the Saturn preview.

2) Download the model - changes in polygon attributes, including texture assignments will
not be visually correct on CartDev unless you re-send the model to the target.

3) Download Scene updates the light vector/color/ambient and background color.

   - If all else fails, re-send everything to the Saturn.

Some Other 3D Editor Features You Should Explore:
------------------------------------------------------------------------
Attributes (Gouraud), Background Color, Camera Views, Hierarchy, Lighting, Property,
Screen, and Slice.
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HOW TO USE MAP EDITOR:
--------------------------------------------------------------------------------------------------------------------------

OPENING A “MAP”:
------------------------------------------------------------------------
Two scenarios are available;
   1) opening an existing map file, or
   2) creating a new map file and importing an image into it.

Scenario 2 will be explained; featuring “New” and “Import”.

- From the “File” menu select “New...” to access a fresh workspace.

- The “New File” dialog appears, click OK. (color mode 256, map size 2x2)

The “Character Window” and the “Map Window” appear.
The “Character Window” is where the individual map TILES are stored.
The “Map Window” is where the assembled MAP is displayed, and later sent to the TV
screen.

THE TOOL BOX:
------------------------------------------------------------------------
You may also notice the “Tool Box”. The functionality of the “Tool Box” differs with the
active window.

Character Window Tool Box functionality:
   Select, Eraser, Eyedropper (Spoit).
Map Window Tool Box functionality:
   Select, Pencil, Eraser, Eyedropper (Spoit), Tiling.

IMPORTING AN IMAGE FILE:
------------------------------------------------------------------------
- From the “File” menu select “Import...” to load an image into Map Editor.

- The “Import” (Open) dialog appears, select a BMP file from the image files provided in the
“map_sam” folder.

Map Editor handles these file types:
(Image files must be multiples of 64 x 64 pixels in size and 256 color).
   OPEN...   S2D
   SAVE...   S2D, SGL (.MAP, .CEL, .PAL)
   IMPORT...   BMP, JPG
   EXPORT...   <none, see save>

- The “Assign Palette” dialog appears, click OK. (This assigns the new image’s palette to
position 0 of the 8 palette spaces available, 0-7)

The image file now appears, in a new third window.
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- With the image file window still active, choose “Select All” from the “Edit” menu.

- Then choose “Copy” from the “Edit” menu.

- Click on the “Character Window” to activate it, and from the “Edit” menu choose “Paste”.

The entire image should now appear in the “Character Window”.

- Click anywhere in the image area of the “Character Window” to de-select the image.

The image is de-selected and the first tile is automatically repeated through-out the “Map
Window”. The initial bitmap image has now transformed into 16x16 tiles. The tiles in the
“Character Window” are now ready to be copied to the “Map Window”.

- Close the image file window.

- From the “View” menu choose “Grid”.

A grid of cross-hairs appears on the “Character Window” delineating the tile boundaries.
(To change the Grid color choose “Property” from the “Edit” menu).

- Use the “Selection” tool to select an area of tiles in the “Character Window”, and then
from the “Edit” menu choose “Copy”.

- Click on the “Map Window” to activate it, and from the “Edit” menu choose “Paste”.

- From the “View” menu choose “Grid”.

- Click anywhere in the image area of the “Map Window” to de-select the image.

- Experiment with the various “Tool Box” tools to see their effects on the Character and Map
Windows.

When editing in the “Map Window”, using the PENCIL tool as a single tile brush, works
well. The “Control” key will toggle Pencil and Eyedropper. Selecting and dragging of tiles
seems very buggy at this time. Cut & paste works well.
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DOWNLOADING TO SATURN (MAP EDITOR):
------------------------------------------------------------------------
- Once the tiles and map are assembled in the “Map Window” the Map can be sent to the
Saturn CartDev.

- From the “View” menu select “Send Target...”.

- The “Send Target” dialog appears, click OK. (normal scroll)

- After a short pause the map should appear on the TV monitor.

Note: The orientation of the map on the TV may be adjusted using the Saturn controller.

MAP EDITOR CONTROLS:
------------------------------------------------------------------------

SCROLL MODE - Map Editor (VDP2)
Allows you to view scroll data as either a rotational background or normal scroll screen.
(For controller use be sure the SS Monitor displays SCROLL mode).

Controls: (NORMAL SCROLL MODE)
   D - pad:              Scroll map

Controls: (ROTATE SCROLL MODES)
   D - pad:             Rotate on Y-axis & translate in Z-axis
   A    button:        Hold and move D-pad to translate
   B    button:        Hold and move D-pad to rotate on Z-axis
   C    button:        Hold and move D-pad to translate back plane
   Start button:     Reset/center map on-screen

- To update any changes to the tile assignments to the map, from the “View” menu choose
“Send Target...”, and click OK. (This is also the only way to reset the map position on the TV
screen).

Some Other Map Editor Features You Should Explore:
---------------------------------------------------------------------------
Edit Palette, Property (Grid), Tiling Tool, Tile Flip, Rotate, Offset, and Sort.
(“Rotate Scroll” from the “Send Target” dialog).
(Open some existing map files).
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MODELS AND MAPS TOGETHER -
--------------------------------------------------------------------------------------------------------------------------

It’s simple...
After downloading a Model just run Map Editor and download a Map, or vise versa!
(Just don’t re-set SS Monitor in between)
Use the controller to switch between the two, and position both the model and the map on
the TV screen.

TECHNICAL NOTES -
--------------------------------------------------------------------------------------------------------------------------

OBJECT MODE NOTES:
------------------------------------------------------------------------
The preview mode runs the VDP1 in 1 cycle mode so you may see polygonal dropout if you
display too many polys or have excessive amounts of Gouraud and texturing in your
model(s) since VDP1 is only allowed 1 cycle to draw all your stuff. This little problem has
been noted and will hopefully be fixed.

MOTION MODE NOTES:
------------------------------------------------------------------------
Motion Mode not implemented yet.

CAUTION (TEXTURE LIST):
------------------------------------------------------------------------
While the texture functionality allows importing of 8 bit textures, the 3D editor currently
only supports 16 bit RGB textures only. All imported textures are converted to 24 bit BMP’s
when added to the texture list. BMP export functionality has a bug that creates invalid BMP
files sometimes- use the TIF format when exporting textures (no bug).

Requests have been made to support paletted and CLUT format.

CAUTION (MAP WINDOW MAXIMIZE):
------------------------------------------------------------------------
BUG:  Use of Map Window’s Maximize/Minimize Window Icon kills all Downloader
functionality for Map Editor. (The “View” menu grays-out for good).

GOURAUD NOTES:
------------------------------------------------------------------------
To enable the real-time Gouraud attribute for polygons in SGL 3.0 make sure the UseLight
AND Gouraud boxes are both checked.

The UseLight option box found under Attribute->Material and
Attribute->Gouraud is the same option.
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SGI NOTES (HrcToSg3):
------------------------------------------------------------------------
To convert a hierarchical model select all objects to be exported in Softimage in Multi-
Selection mode. Select only the polygonal mesh portions of the model - you may select any
NULLS, Chains and Effectors as well but the conversion tool will treat them as polygonal
objects with no faces. In Softimage choose Save -> selected models and specify the name of
the hrc file. Run HrcToSg3 on the HRC file.

Here's a little UNIX script to convert all HRC's in a directory to SG3 format:
#! /bin/csh
set filter = 'hrc'
set list   = `ls *.$filter`
foreach file ( $list )
hrc2sg3 -sg3rb $file

end

3D EDITOR/SG3 SAMPLE MODEL NOTES:
------------------------------------------------------------------------
a) Because some demo models use collapsed vertices to create concave quad polygons
(sonic3.sg3/concave.sg3). These will not display correctly in Win95 3D Editor because the
editor renders in triangles. However when the model is viewed on Saturn or with
SSMonitor/Viewer they will be correct.

b) Since the SG3 model file only remembers the texture reference number in its data file, it
is possible to load any SGT (texture) file and have the results applied to the currently loaded
model. This is useful if you are creating multiple texture 'outfits' for characters, sort of like
the multi-skin feature in quake.

c) Sometimes a vertex normal for a real-time Gouraud model is not correct (causes a dark or
very bright spot in Gouraud polygon). This usually happens when quads are non-planar or
concave - to fix this, rotating the vertices of the polygons affected will usually fix this
problem.

d) All objects by default are rotated in the viewer around the origin which may make object
manipulation difficult for objects with coordinates far from the origin.
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LIST OF SAMPLES -
--------------------------------------------------------------------------------------------------------------------------

ABOUT 3D EDITOR MODEL SAMPLES:
------------------------------------------------------------------------
   The models were created in Softimage.
   The SG3 files are the models.
   The SGT files are the textures.

   Load a SG3 file by selecting “Open...” from 3D Editor’s “File” menu.
   Load a SGT file by selecting “Open...” from 3D Editor’s Texture List “File” menu.
   Load a BMP or JPG file by selecting “Import...” from 3D Editor’s Texture List “File” menu.

3D EDITOR SAMPLES:
------------------------------------------------------------------------
folder:
   sg3_sam

concave1.sg3  (4 polygons)
concave2.sg3 (10 polygons)
concave3.sg3 (10 polygons)
dragon.sg3 (152 polygons)
fish_sub.sg3 (275 polygons)
hover.sg3 (62 polygons)
   hover.sgt   (4 textures)
monitor.sg3 (44 polygons)
   monitor.sgt   (1 texture)
mt_sonic.sg3 (464 polygons)
sonic3.sg3 (214 polygons)
   sonic3.sgt   (12 textures)
terrain.sg3 (100 polygons)
   terrain.sgt   (6 textures)
torus.sg3 (64 polygons)

Additional 3D Editor Texture Samples (64x64)
------------------------------------------------------------------------
folder:
   jpg_sam

4Sands_Y.jpg
4Sands_G.jpg
GDot01.jpg
Green01.jpg
RSand01.jpg
RSand02.jpg
RSand03.jpg
RSand04.jpg
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Sand01.jpg
Sand02.jpg
Sand03.jpg
Sand04.jpg

MAP EDITOR SAMPLES:
------------------------------------------------------------------------
folder:
   map_sam

Beach.bmp   (512x512)
Bkgnd16.bmp   (304x160) (16 color)
Corona.bmp   (192x192)
Corona.s2d
Dino.bmp   (112x80) (16 color)
SandBox.bmp   (323x243)
SatSteel.bmp   (320x256)
SatSteel.s2d
SunSet.bmp   (576x451)
SunSpot.s2d

SEGA DTS AUTHORS:      1996.11.04
------------------------------------------------------------------------
Chris Coffin
Sega - Advanced Development Engineer

Dick Holmes
Sega - Graphics Technical Director

Please report any bugs, comments or questions to:  dts@sega.com
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3D Editor

     About the 3D Editor   
    3D Editor File Formats   

    ToolBox    
    File Menu    
    Edit Menu    

     View Menu    
     Options Menu    

     Help Menu    

• About the 3D Editor
The 3D Editor reads special format 3D object files, and can reference 3D models with
optional orientation and sizing. It can also add attribute information such as colors and
texture maps to polygons in the 3D model.

Also, extending texture mapping over multiple surfaces, which was a difficult operation
in the Sega Saturn system, is simplified by the Auto Slice Texture function.

• 3D Editor File Formats
The 3D Editor handles the following file formats.

[Open]
SG3 Files

Binary files containing object (model) information.
SGT Files

Binary files containing texture information.

[Save]
SG3 Files

Binary files containing object (model) information.
SGT Files

Binary files containing texture information.
MDL Files

C language data files containing object (model) information.
TXR Files

C language data files containing texture information.

[Import]
[Export]

BMP Files and others
Data to be used for texture mapping.
Extensible and modifiable by plug-in modules.
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• ToolBox
The ToolBox is displayed in a working window. Basic operations that can be performed in
the main window, such as rotation and movement of an object, and polygon selection,
can be  accessed using the ToolBox.

      Rotate Model   

       Move Model   

     Scale Model   

     Select Polygon    

       Move Slice Texture    

     Select Camera    

•  Rotate Model
[Drag]

Rotates the whole model around three axes of rotation by moving the mouse. The
center of rotation is the centerpoint of the model.

[Shift + Drag]
Rotates the whole model around one axis of rotation by moving the mouse. The
rotation axis is the line of sight.

•  Move Model

[Drag]
Moves the whole model parallel to the projected side.

[Shift + Drag]
Horizontal mouse motion moves the whole model left and right (on the XY plane).
Vertical mouse motion moves the whole model front and back (on the XZ plane).

•  Scale Model

[Drag]
Enlarges or reduces the whole model. The center of scaling is the centerpoint of the
whole model.
Upward mouse motion reduces the size of the whole model.
Downward mouse motion enlarges the size of the whole model.
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•  Select Polygon

[Click (Drag)]
Selects the polygon at the click (drag) location. The selected polygon is displayed as a
mesh.

When starting a drag from a location outside of any polygon, a marquee (rectangular
frame with dotted outline) appears and is sized according to motion of the mouse.
When finished dragging, any polygons having all of their vertices surrounded by the
marquee are selected.

[Control + Click (Drag)]
Cancels polygon selection. Operation is the same as for selecting polygons.

[Shift + Click (Drag)]
Selects the whole model containing the polygon at the click (drag) location. This is
mainly used to select the hierarchy of a member object.

•  Move Slice Texture

[Drag Inside]
Move the texture to be used for a slice.

[Drag Control Point]
Change the size of the texture to be used for a slice.

•  Select Camera

Select the default or a custom camera.

Related Item:
      Options Menu    

• File Menu
Provides file management, such as opening and saving model files. Also allows exiting
the editor.

 Open
Opens a previously saved SG3 format file. If another file is already open, that file is
automatically closed (only one map can be edited at a time with the 3D Editor).

 Save
Saves the current file in SG3 format.
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 Save As
Saves the current file with a different name.

 1 ~ 4
Displays the last four most recently opened or saved files.

 Exit
Closes the 3D Editor.

Related Item:
    3D Editor File Formats   

• Edit Menu
Use this menu to control polygon selection in the 3D Editor, and to configure the working
environment.

 Undo
Cancels the most recent operation. Note that not all operations can be canceled.

 Cut
 Copy
 Paste
 Delete

 Not yet implemented.

 Tool
Each sub-menu corresponds with a button in the     ToolBox    .

 Select Model
Selects the whole model that includes the currently selected polygon.

 Select Material
Selects all polygons that have the same material information as the currently selected
polygon.

 Select All
Selects all polygons in all models.

 Cancel Selection
Cancels the selection of all polygons in all models.

 Properties
Configures the 3D Editor environment.
[Color]

Specifies the colors of the display and each editing function.
 Background Color
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Specifies the background color.
 Selected Polygon

Specifies the mesh color for display of selected polygons.
 Transparent Color

Specifies a color to indicate transparency during texture data editing.
 Custom Color Dialog

When checked, the color selection dialog displays the custom dialog to access the RGB
sliders.
When not checked, the standard windows color selection dialog is used.

[Drag]
Selects a display method for a model during mouse drag operations, such as rotating and
moving, in the main window. This is mainly intended to avoid problems that can result
from speed differences in different development platforms.
 Display as Wire Frame

Displays models as wire frames while dragging. This is generally the most comfortable
method.

 Display as Flat Polygon
Displays models as flat (untextured) polygons with light source calculation while
dragging. This method is a little slower, but it provides a somewhat better
representation of the model during dragging.

 Display with All Properties
Displays models with all of their characteristics during dragging. Performance depends
on material settings, but this method provides the most accurate appearance (and is
the most processor intensive) while dragging.

• View Menu
Selects display of the sub windows and toolbox, and allows setting the target display to
correspond with the SS Monitor/SS Viewer.

 ToolBox
Displays or hides the toolbox.

 Attributes
Displays or hides the Attribute window.

 Hierarchy
Displays or hides the Hierarchy window.

 Texture List
Displays or hides the Texture List.

 Target Display
Sends to and displays the current file on the target. The SS Monitor must be executed and
the SS Viewer must be running before using this function.

 Model
Transfers the model data.
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Note: This selection transfers only the texture numbers in the attribute data for each
surface. Before texture map data can be applied, the actual texture data for each surface
has to be transferred separately for each model.
 Texture
Transfers the texture data.
 Environment
Transfers environment data, such as light source direction and color, and ambient
colors.

• Options Menu
Sets 3D environment properties such as the light source, projection side and cameras.
Special operations on the vertices and sides are also available here.

 Light Source
Sets light source direction and colors.
[Dialog box]
Direction

Move the red circle indicating the control point to specify the light source direction.
 Front

Selects the front hemisphere.
 Back

Selects the back hemisphere.
Colors

Specify the colors of the light source and environment.
 Light Source

Set the light source color.
 Environment

Set the environment color.

 Screen
Accesses various settings for the 3D projection side (screen).
[Dialog box]
Projection

Select the projection method for the screen.
 Parallel Projection

Project to ignore depth (Z values)
 Perspective

Project by parsing according to depth (normal selection).
View Angle

 Slider
Specifies the viewing angle to the projected area. This setting is irrelevant when
Parallel Projection is selected.

 Select Camera
Select the default camera (at the standard viewpoint), or a custom camera (at a user
specified location).
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 New Camera
Add a custom camera at the current viewpoint, selected by number on the sub-menu.
When the number of an existing camera is selected, its location is replaced by the current
viewpoint.

 Rotate Vertex Order
Redefines the order of the vertex numbers of the currently selected polygon. This is
mainly intended for changing texture mapping directions without altering the texture
data. Note that there are certain cases where using this menu for a triangular polygon will
result in data that is incompatible with SGL format.
 90° Clockwise

Redefines the vertex order 90° clockwise relative to the front of the polygon.
 90° Counterclockwise

Redefines the vertex order 90° counterclockwise relative to the front of the polygon.
 180°

Redefines the vertex order 180° relative to the front of the polygon.

 Reverse View
Redefines the vertex order on the normal vector of the selected polygon to face in the
opposite direction. If texture has been applied, the texture flag of the attribute information
is also reversed so as to maintain the appearance of the original image.

 Create Gouraud Table
If real-time Gouraud (shading to calculate the light source) has been applied to the
attribute information of the selected polygon, a Gouraud Table can be created so that the
Gouraud shading is applied using fixed table values derived from the current color and
direction of the light source (instead of recalculating).
This is mainly intended to speed real-time display of Gouraud shading (by eliminating the
time needed to recalculate).

• Help Menu
Displays this Help for using the 3D Editor, and information about the 3D Editor.

 Contents
Displays the Help menu contents.

 About
Displays 3D Editor version information.
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Editing Texture Data

    File Menu    
    Edit Menu    

     Options Menu    
    Slice Texture Function    

• File Menu
Manage Texture File input and output.

 Open
Opens a previously saved SGT format file. If a file is already open, the texture data
definitions in the file are overwritten automatically.

 Save
Saves the current file in SGT format.

 Save As
Saves the current file as a new file under a different name.

 1 ~ 4
Displays the names of the four most recently opened or saved files are displayed.

 Import
Opens the 2D image file containing texture data to be used, and registers the position o f
the currently selected texture number in the texture window as texture data. If texture data
already exists, it is overwritten.

 Export
Saves texture data to a 2D image file.

[Dialog Box]
"Save"

Selects the conditions for saving texture data.
 All

 Saves all registered data.
 Selected Texture

 Saves the currently selected texture.
 ID Area

 Saves the texture data area specified by the texture number.

Related Items:
    3D        Editor        File        Formats   
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• Edit Menu
Edits texture data, such as by cut and paste. Also displays information about the size of
texture data.

 Undo
Undoes the last operation. Note that some operations cannot be undone.

 Cut
Cuts selected texture data. Cut data is stored on the clipboard.

 Copy
Copies selected texture data. Copied data is stored on the clipboard.
Note: Clipboard data is stored in DIB format, so it can be pasted to other applications.

 Paste
Pastes texture data from the clipboard to the currently selected texture number location.
Note: Clipboard data stored in DIB bit format can be pasted to other applications.

 Delete
Erases selected texture data.

 Delete All
Erases all registered texture data.

 Insert
Inserts a blank texture at the selected texture number location, and rearranges the data
following.
Hold the Shift key when selecting this item to maintain the relationships of texture data
already applied.

 Backspace
Deletes the selected texture data and rearranges the data after the selection to close space.
Hold the Shift key when selecting this item to maintain the relationships of texture data
already applied.

 Clear Clipboard
Deletes any data stored on the clipboard.

 Texture Info
Displays information about selected texture data, such as its size.
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• Options Menu
Changes the direction and size of texture data. Basic operations such as cutting textures are
also done here.

 Invert
The specified texture is inverted symmetrically about the centerline.
[Dialog Box]
"Invert Direction"

Specifies the inversion direction.
 Horizontal

Inverts horizontally
 Vertical

Inverts vertically (lengthwise)
"Texture to Change"

 Specifies the texture data to invert.
 Texture Selection

Inverts the currently selected texture.
 Specified ID Area

Inverts the texture data specified by the texture number.

 Rotate
Rotates the specified texture.
[Dialog Box]
"Rotation Direction"

Specifies the direction of rotation.
 90 clockwise

 Rotates 90 clockwise
 90 counterclockwise

 Rotates 90 counterclockwise
 180

 Rotates 180
"Texture to Change"

 Specifies the texture data to rotate.
 Texture Selection

Rotates the currently selected texture.
 Specified ID Area

Rotates the texture data specified by the texture number.

 Resize
Changes the size of the specified texture.
[Dialog Box]
"Size"

 Specifies the desired change in size.
 H

Enter the desired horizontal size.
 V

Enter the desired vertical size.
"Smooth"
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When the new size is to be larger, process to remove jaggies.
"200%"

Magnify by 2x, horizontally and vertically.
"50%"

Reduce by 2x, horizontally and vertically.
"Texture to Change"

 Specifies the texture data to resize.
 Texture Selection

Resizes the currently selected texture.
 Specified ID Area

Resizes the texture data specified by the texture number.

 Slice Texture Display
Displays the layers of the currently selected texture data in the main window. When the
texture is displayed, the size and position can be changed freely with the       Move Slice
    Texture     tool in the main window.

 Texture Slice
Based on the size and position information of the currently displayed slice texture data,
new texture data is automatically created and applied to the selected polygon.
Details:

    Slice        Texture        Function    

 Down
 Up
 Page Down
 Page Up

Scrolls the texture list as indicated.

• Slice Texture Function
The Slice Texture function provides a projection of the selected polygon parallel to the
line of sight, based on the size and position information of the currently displayed sliced
texture data. Based on the relative vertex coordinate information of each projected
polygon, the most suitable texture data is created to allow the image to be displayed
optimally in the main window, taking into account the transformation sprite treatment by
Sega Saturn. Newly created texture data is applied automatically to correspond with each
polygon, and the results are immediately reflected in the attribute information.

[Dialog Box]
"Size"

Specifies the size of the texture data to be created.
 H

Enter the horizontal size of the texture data.
 V

Enter the vertical size of the texture data.

"Offset"
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Select a processing method to be applied to the area around the currently displayed slice
texture data.
 Transparent

 Process as transparent pixels.
 Repeat

 Repeat to process the edge data of the slice texture data.
 Wrap Around

 Fold back the slice texture data.

"Smooth"
Process sliced texture data to remove jaggies.

"Material Color"
Process using polygon colors to set the transparency pixels of the sliced texture data on
each side.

"Add Position"
Specify the first number at which to position created texture data. Multiple sliced texture
data are positioned in order after the texture number specified here. Existing texture data
is overwritten by the created data.
 Add Immediately

Position immediately after the selected texture number.
 Add at End

Add to the end of registered texture data.
 Specify ID

Position according to the specified texture number.

• Attribute Settings
Attribute data such as colors and display methods can be set for each polygon in the model
structure using the 3D Editor.

      Material   
Sets properties related to the material, such as the color and texture mapping of each
polygon.

      Mode    
Sets painting method information for each polygon.

    Zsort   
Sets the Z-sort graph.

     Gouraud    
Sets Gouraud shading information.

     Options   
Sets optional attribute information.

Note: The attribute settings of the 3D Editor comply with the Sega Saturn VDP1 and SGL
standards, so basic knowledge of those systems is required to use the attribute editing
functions properly.
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• Material Settings
 Set color and texture mapping information for the currently selected polygon. Settings are
applied to the object polygon by clicking the Refresh button.

 Polygon
Draw object as a polygon.

 Polyline
Draw object as a polyline.

 Texture Map
Draw as sprites (texture map). Texture data to be applied is specified numerically.

 Light Source
Calculate light source.

 Color
Specify the non-texture color.

 Sprite ID
Specify the texture data number to be applied as a texture map.

 H flip
Display texture data reversed horizontally.

 V flip
Display texture data reversed vertically.

• Mode Settings
Set drawing method information for the currently selected polygon. Settings are applied
to the object polygon by clicking the Refresh button.

 Replace
Displays as itself.

 Shadow
Displays with shadow.

 Half Brightness
Displays with half brightness.

 Half Transparent
Displays with half transparency.

 Mesh
Displays with mesh.

• Z-Sort Settings
Set the Z-sort base point of the currently selected polygon. Settings are applied to the object
polygon by clicking the Refresh button.

 Center Point
The base point will be the center of the polygon.

 Closest Point
The base point will be the front-most vertex of the polygon.

 Farthest Point
 The base point will be the rear-most vertex of the polygon.
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• Gouraud Settings
Set up Gouraud Shading settings for the currently selected polygon. Settings are applied to
the object polygon by clicking the Refresh button.

 Gouraud
Execute Gouraud shading.

 Light Source
Calculate the light source.

 Gouraud table •0 to •3
Specify the Gouraud tables for the 4 vertex values.

Note: The actual shading processes for each Gouraud setting and light source selection are
as follows:

1) Gouraud = OFF, Light Source = OFF:
 Flat Color

2) Gouraud = OFF, Light Source = ON:
 Flat Shading

2) Gouraud = ON, Light Source = OFF:
 Gouraud Shading from Table

2) Gouraud = ON, Light Source = ON:
 Real-time Gouraud Shading

• Options Settings
Set other option attribute information for the currently selected polygon. Settings are
applied to the object polygon by clicking the Refresh button.

"Plane"
Select a method to handle hidden surfaces.
 One Side
 Process to show only one side of the polygon.
 Both Sides
 Process to show both sides of the polygon.

 Near Clip
 Force display even when the polygon changes shape near the viewpoint.

• Editing Attribute Data

     Open          Model        File    
    Change          Model         View     
    Set        Polygon        Color   
    Set        Polygon        Texture    
    Set        Polygon        Z-Sort        Flag    
    Save          Model        File    
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• Editing Texture Data

     Open        Texture        File    
   Import        Texture         Data       f      rom        2D       Image        File    
     Use        Slice        Texture        Function    
    Export        Texture         Data       to        2D       Image        File    
    Save        Texture        File    

• Open Model File

To open a model file:

1) Select File  Open from the main window.

Related Items:
    File          Menu    
    3D        Editor        File        Formats   

• Change Model View

To change the viewing direction of the model:

1) Select the Rotate Model tool.
2) Drag in the main window.
3) The model rotates.

1) Select the Move Model tool.
2) Drag in the main window.
3) The model moves.

1) Select the Select Camera tool.
2) Select the camera on the pop-up menu.
3) The viewpoint moves to the camera position.

Related Items:
     Rotate          Model       tool   
      Move          Model       tool   
    Select        Camera       tool   
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• Set Polygon Color

To set the color of a polygon:

1) Select the Select Polygon tool.
2) Select the polygon for which you want to set the color in the main window.
3) Select View  Attribute to display the Attribute window (if the Attribute window is not
already displayed).
4) Click on the Material tab of the Attribute window to activate the material setting mode.
5) Select the Polygon radio button.
6) Click the Color box to display the color setting dialog box.
7) After selecting the desired color, click OK.
8) Click the Refresh button.
9) The color is applied to the selected polygon.
10) Cancel the polygon selection by Edit  Cancel Selection.

Related Items:
    Select        Polygon       tool   
     View          menu    
    Edit          menu    
      Material        Setting    

• Set Polygon Texture

To set the texture of a polygon:

1) Select the Select Polygon tool.
2) Select the polygon for which you want to set the texture in the main window.
3) Select View  Attribute to display the Attribute window (if the Attribute window is not
already displayed).
4) Click on the Material tab of the Attribute window to display the material settings.
5) Select the Texture Map radio button.
6) Enter the desired texture number for the sprite ID.
7) Click the Refresh button.
8) The texture is applied to the selected polygon.
9) Cancel the polygon selection by Edit  Cancel Selection.

Or for a simplified way to set the texture of a polygon:
1) Select the Select Polygon tool.
2) Select the polygon for which you want to set the texture in the main window.
3) Select View  Attribute to display the Attribute window (if the Attribute window is not
already displayed).
4) Double click inside the display frame of the desired texture number.
5) The texture is applied to the selected polygon.
6) Cancel the polygon selection by Edit  Cancel Selection.
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Related Items:
    Select Polygon tool   
     View menu    
    Edit menu    
      Material Setting    

• Set Polygon Z-Sort Flag

To set the Z-sort flag for a polygon:

1) Select the Select Polygon tool.
2) Select the polygon for which you want to set the Z-sort flag in the main window.
3) Select View  Attribute to display the Attribute window (if the Attribute window is not
already displayed).
4) Click on the Zsort tab of the Attribute window to activate the Zsort setting mode.
5) Select the desired radio button.
6) Click the Refresh button.
7) The Z-sort flag is applied to the selected polygon.
8) Cancel the polygon selection by Edit  Cancel Selection.

Related Items:
    Select Polygon tool   
     View menu    
    Edit menu    
    Z-Sort Setting    

• Save Model File

To save a model file…

…in SG3 format:
1) Select File  Save from the main window.

…in MDL format:
1) Select File  Save As from the main window.
2) Select MDL Files from the combo box.

Related Items:
    File Menu    
    3D Editor File Formats   
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• Open Texture File

To open a texture file:

1) Select File  Open from the Texture window.

Related Items:
    File          Menu    
    3D        Editor        File        Formats   

• Load Texture Data From 2D Image File

To load texture data from a 2D image file:

1) Select File  Import from the Texture window.

Related Items:
    File Menu    
    3D Editor File Formats   

• Using the Texture Slice Function

To use the Texture Slice function:

1) Select the Select Polygon tool.
2) Select the polygon for which you want to set the texture in the main window.
3) Select View  Texture to display the Texture window (if the window is not already
displayed).
4) Click in the display frame of the texture number for the desired slice to select it.
5) Select Options  Texture Slice in the Texture window to display the slice texture.
6) Select the Move Slice Texture tool.
7) Move the slice texture to the desired size and position.
8) Select Options  Texture Slice in the Texture window
9) Set the desire slice conditions in the dialog box, and click OK.
10) The texture is applied to the selected polygon.
11) Cancel the polygon selection by Edit  Cancel Selection.

Related Items:
    Select Polygon tool   
      Move Slice Texture tool   
    Slice Texture function    
     View menu    
    Edit menu    
     Options menu    
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• Save Texture Data to a 2D Image File

To save texture data to a 2D image file:

1) Select File  Export from the Texture window.

Related Items:
    File Menu    
    3D Editor File Formats   

• Save Texture File

To save a texture file…

…in SGT format:
1) Select File  Save from the Texture window.

…in TXR format:
1) Select File  Save As from the Texture window.
2) Select TXR Files from the combo box.

Related Items:
    File Menu    
    3D Editor File Formats   
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Map Editor
part 1

     Open New File    
    Character Entry    

    Edit Map    
    Save File    
     Open File    

• Open New File

To open a new file:

1) Select File  New.

Related Items:
    File          Menu    

• Character Entry

To enter a character:

1) Select File  Import on the menu.
2) Select the object to be entered as a character using the Rectangular Selection tool in the
image window.
3) Select Edit  Copy on the menu.
4) Bring the Character window to the front.
5) Select Edit  Paste on the menu.
6) Move the pasted character to the location where you want it entered.
7) Click the target position in the window.

Related Items:
    File          Menu    
    Edit          Menu    
     Rectangular        Selection        Tool   
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• Edit Map

To place any character on the map:
1) Select the Pen tool from the Toolbox.
2) Click on Desired Character in the Character window.
3) Drag (draw) a character on the Map window at the desired location.

To place several characters on the map:
1) Select the Rectangular Selection tool from the Toolbox.
2) Select the characters in the Character window.
3) Select Edit  Copy on the menu.
4) Bring the Map window to the front.
5) Select Edit  Paste on the menu.
6) Move the pasted character group to the desired location.
7) Click the target location in the window.

Related Items:
    File Menu    
    Edit Menu    
     Rectangular Selection tool   
    Pen Tool   

• Save File

To save a file in S2D format:
1) Select File  Save on the menu.

To save a file in SGT format:
1) Select File  Save As on the menu.
1) Select SGL Files in the combo box.

Related Items:
    File Menu    
      Map Editor File Formats   

• Open File

To open an existing S2D file:

1) Select File  Open.

Related Items:

    File Menu    
      Map Editor File Formats   
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Map Editor
part 2

     About Map Editor   
      Map Editor File Formats

    ToolBox
    File Menu
    Edit Menu

     View Menu
    Character Menu

      Map Menu
      Window Menu

     Help Menu    

• About Map Editor

The Map Editor application reads 2D Image data files that have been saved in a standard
format, and divides the picture elements into 16-by-16 pixel character units, which can
then be repositioned as desired in the map area. Standards for the Map Editor character
map comply with the Sega Saturn VDP2 System specification. Basic knowledge of the
VDP2 System is required for effective use of the Map Editor.

Maps with the following color modes can be edited with the current version of the Map
Editor.

1) 256 colors / 32,768 colors
2) 32,768 colors

• Map Editor File Formats

The following formats can be handled independently by the Map Editor:

[Read]
S2D Files

Binary files that include character map palette information.

[Save]
S2D Files

Binary files that include character map palette information.
SGL Files

C language data files that include character map palette information.

[Import]
BMP Files and others

Data to be used as character objects.
Can be added and modified by plug-in modules.
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• ToolBox
The ToolBox displays in the working window. Basic operation such as area selection and
character positioning can be performed using the ToolBox.

      Rectangular Selection Tool   

     Pen Tool   

     Eraser Tool   

     Eyedropper Tool   

     Tile Tool   

•  Rectangular Selection Tool

[Map Window]
[Character Window]
[Image Window] (in common)
 When Selecting

Drag:
Selects within rectangular area.

 After Selecting
Drag:

Moves the data in the selected area.
Ctrl + Drag:

Pastes and moves the data in the selected area.
Click:

Pastes the data in the selected data, and cancels the selection.

•  Pen Tool

[Map Window]
Drag:

Positions a specific character on the map.
Note: When a selection area has been set, the positioning of character data is clipped
within the selected area.

Ctrl +  Drag (Click)
Specifies the character at the cursor location. Acts the same as the Eyedropper tool.

[Character Window]
Click:

Specifies the character at the cursor location.

[Image Window]
Not available.
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•  Eraser Tool

[Map Window]
Drag:

Places character 0 data on the map.

[Character Window]
Drag:

Makes the character data at the cursor location a Space character.

[Image Window]
Not available.

•  Eyedropper Tool

[Map Window]
Ctrl + Drag (Click):

Specifies the character at the cursor location. Acts the same as the Pen tool.

[Character Window]
Click:

Specifies the character at the cursor location.

[Image Window]
Not available.

•  Tile Tool

[Map Window]
Drag:

Align and place character data from the clipboard.
Note: When a selection area has been set, the positioning of character data is clipped
within the selected area.

[Character Window]
Not available.

[Image Window]
Not available.
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• File Menu
Provides file management, such as opening and saving files. Also allows exiting the
editor.

 New
Creates a new file.
[Dialog Box]
 Color Mode

Selects the color mode for a new file.
 Size

Enter the horizontal and vertical size of the new file. The units are pages, where one
page is 512 x 512 pixels (32 x 32 characters).

 Open
Opens a previously saved file. If another file is already open, that file is automatically
closed. The Map Editor can edit only one file at a time.

 Save
Saves the current file.

 Save As
Saves the current file with a different name. When saving an     SGL File    , SGL Option flags
must be set.

Related Item:     SGL Options   

 Import
Opens a 2D image data file to provide character data and a display image window.
[Dialog] (Displayed in 256-color mode)
 Scroll Bar

Specifies a palette to assign to the image window.
 Overwrite

When checked, the color table for the image is placed on the specified palette.

 1 ~ 4
Displays the last four most recently opened or saved files.

 Exit
Closes the Map Editor.
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• Edit Menu
Provides image editing functions such as cut and paste, and sets the Map Editor working
environment.

 Undo
Cancels the most recent operation. Note that not all operations can be canceled.

 Cut
Cuts the selected data to the clipboard. Data cut from the Character and Map windows can
be used as settings for the     Tile Tool   .
Related Item:     Tile Tool   

 Copy
Copies the selected data to the clipboard. Data copied from the Character and Map
windows can be used as settings for the     Tile Tool   .
Related Item:     Tile Tool   

 Paste
Data that has been saved on the clipboard is pasted into the current working data. The
pasted data can be repositioned immediately after it is pasted (floating state).
The Paste function can be used between windows that hold compatible data.
Example:

Image Window  Character Window
Image data pixel information can be pasted as character data.

Character Window  Map Window
Character data settings can be pasted as Map information.

 Delete
Erases the data in the selected area.

 Select All
Selects the whole current window.

 Cancel Selection
Cancels all selections in the current window. Floating data is placed at its current location.

 Tool
Each sub-menu corresponds with a button in the     ToolBox    .
Related Item:     ToolBox    

 Properties
Sets up the Map Editor environment.  [Grid Color]

 Map Window
Specifies the grid color of the Map window.

 Character Window
Specifies the grid color of the Character window.

 Image Window
Specifies the grid color of the Image window.
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• View Menu
Changes display magnification of the current working window, selects display/non-
display of the toolbox, and allows setting the target display to correspond with the SS
Monitor/SS Viewer.

 Magnification
Displays the current working window with the specified magnification.

 Grid
Displays/hides the character-unit grid in the current working window. Also displays the 1-
Mb bank-unit grille in the Character window, and the page-unit grille in the Map window.

 ToolBox
Displays or hides the toolbox.

 Target Display
Displays the current file on the target. The SS Monitor must be booted and the SS Viewer
executed before using this function.

[Dialog Box]
Scroll Type

Select a scroll type for the display.
 Normal Scroll

Displays with normal scroll. The top and bottom, and left and right edges of the map
are linked to wrap around.

 1 x 1 Rotation Scroll
The first 1 x 1 plane unit map constitutes the floor, and the next 1 x 1 plane unit map
displays the rotation scroll screen that constitutes the sky. The floor can be rotated
about 3 axes.

 4 x 4 Rotation Scroll
The first 4 x 4 plane unit map constitutes the floor, and the next 1 x 1 plane unit map
displays the rotation scroll screen that constitutes the sky. The floor can be rotated
about 3 axes.

Screen Overtreatment
Select display treatment outside of the area (in 4 x 4 plane units) of the rotation scroll
that constitutes the floor side.
 Transparent

Displays the outer area as transparent.
 Repeat

Repeats the display area map in the outer area.
 Within 512 x 512 Dots

Displays the area outside of 512 x 512 dots as transparent.
 Specified Character

Repeatedly displays the character specified in the index.
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• SGL Options
When a file is saved in SGL format and displayed on the target, the VDP2 flags must be set
appropriately. For details on each flag, refer to the "Saturn Hardware Manual".
[Dialog Box]

 Plane Size
Specifies the plane size (in page units). When the map size (in page units) is not
divisible by whole plane units, that plane size cannot be selected.

 Character Control Data
Specifies the data size of pattern name data.

 Character Numbering Assistance Mode
When character control data is one word, specifies the bits used for character
numbering.

• Character Menu
When the Character window is active, this menu allows editing the character data of the
selected area or the whole window.

 Reverse
Characters in the selected area are reversed around the centerline of the selected area, with
line symmetry.

 Horizontal
Reverse side-to-side.

 Vertical
Reverse top-to-bottom.

 Rotate
Rotate characters in the selected area around the centerpoint of the selected area. After
rotation, the characters in the selected area are in the floating state.
 90° Clockwise

Rotate 90° clockwise.
 90° Counterclockwise

Rotate 90° counterclockwise.

 Display Palette
The color table used for the character window display is selected as the color palette.
Note: The palette set here does not affect character palette information in the output file. It
is intended to help the editing process based on intuitive visual effects.
 Palette

Specifies the palette number for display.

 Character Sort
Merge common character data in the selected area, and rearrange in descending order.
Map data is changed according to the results of the sort. This is intended mainly to
remove unneeded character data to minimize the amount of data within a limited area.

 Offset
Characters within the selected area are moved by a specified offset. Map data is changed to
reflect the result.
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[Dialog Box]
 Offset

Specifies the offset amount for the characters.

• Map Menu
When the Map window is active, this menu allows editing the map data of the selected
area or the whole window. Also allows operations such as setting and changing the color
palette.

 Reverse Horizontal
Sets horizontal reverse flag for selected area map data.

 Reverse Vertical
Sets vertical reverse flag for selected area map data.

 Palette
Specifies the palette number for the selected area map data.
[Dialog Box]
 Palette

Specifies the palette number.

 Map Size
[Dialog Box]
Changes the edit area of the Map window.

 Horizontal Size
Specifies a new horizontal size of the map, in page units.

 Vertical Size
Specifies a new vertical size of the map, in page units.

 Edit Palette
Changes and edits the color palette.
[Dialog Box]

 Click Color List
Changes the color data at the selected location.

 Scroll Bar
Changes the index of the palette to be edited.
Color Balance
 Adjusts the color balance of the currently displayed palette.
  R

Adjusts red intensity.
  G

Adjusts green intensity.
  B

Adjusts blue intensity.
Color Hue, Saturation, Brightness

Adjusts the color of the currently displayed palette.
  H
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Adjusts color hue.
  S

Adjusts color saturation.
  L

Adjusts color brightness.
Edit

Move and copy the currently displayed palette.
  Cut

Cuts the palette. The cut palette is replaced by black code.
  Copy

Copies the palette. The copied palette is unaffected.
  Paste

Pastes the palette that was cut or copied beforehand.
  Delete

Deletes the palette. The deleted palette is replaced by black code.

• Window Menu
Shows the types and names of currently open windows, and determines how they are
positioned.

 Cascade
Cascades windows in layers offset from the upper left.

 Tile Vertically
Displays all windows, tiled from top to bottom.

 Tile Horizontally
Displays all windows, tiled from left to right.

 Align Icons
Aligns the icons of all minimized windows.

• Help Menu
Displays this Help window describing how to use the Map Editor, and general
information about the Map Editor.

 Contents
Displays the Help contents.

 About
Displays general information such as the Map Editor version.
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SS Monitor

     About SS Monitor
     About SS Viewer   
     About SS Debug

    File Menu
    Control Menu

     Help Menu
    Troubleshooting    

• About SS Monitor

SS Monitor provides the dynamic data communication protocol between an application
and the DevSaturn target, through the CartDev system. Through this communications
protocol, users can access the Sega Saturn as though it was an external PC device, for
running compliant applications.

Related Items:
About SS Viewer
About SS Debug

• About SS Viewer

When SS Monitor is loaded, it runs the general-purpose viewer program, SS Viewer. The
SSSDK Graphic Tool provides the target display functions for data (or commands)
transferred to the reserved memory map of SS Viewer, through communication between
the applications.

SS Viewer supports the following display functions:
1) 3D Objects
2) 3D Animation
3) Normal Scroll
4) Rotation Scroll (3 axes)
5) Bitmaps

• About SS Debug

SS Debug allows more detailed control of the target system when executed in place of SS
Viewer at boot time. It is recommended when you need to use a customer display
program other than SS Viewer for development.

Note: SS Debug cannot use the SSSDK Graphic Tool directly.
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• File Menu
Provides basic control of the Monitor, and allows exiting the program.

 Load Monitor
Downloads the monitor program. Not normally used.

 Open COFF (SS Debug only)
Downloads and executes a COFF (executable) file.

 Open Binary (SS Debug only)
Downloads a binary file.
[Dialog Box]
 Address

Specifies the download source address in hex.
 VDP1

Specifies the head address ($25c00000) of VDP1.
 VDP2

Specifies the head address ($25e00000) of VDP2.
 SGL

Specifies the head address ($06004000) of SGL user area.
 COL

Specifies the head address ($25f00000) of Color RAM.
 USER

Specifies the input address for the user-reserved box.

 Exit
Closes the application.

• Control Menu
Provides basic control of the target.

 Execute Viewer
Downloads and executes SS Viewer. Not normally used.

 Set PC (SS Debug only)
[Dialog Box]

Sets the Program Counter. Program execution is stopped.
 Address

Specify download source address in hex.
 SGL

Specifies head address ($06004000) of SGL user area.
 USER

Specifies the input address for the user-reserved box.

 Run (SS Debug only)
Executes the program from the current program counter.
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 Stop (SS Debug only)
Stops execution of the program.

 Reset
Resets the target.

• Help Menu
Display this Help window describing how to use SS Monitor, and general information
about SS Monitor.

 Contents
Displays the Help contents.

 About
Displays general information such as the SS Monitor version.

• Troubleshooting

SS Viewer Runaway
When the SS Viewer fails to respond to the SSSDK Graphic Tool, it can be rebooted by the
following procedure.

1) Select Control  Reset
2) Select File  Load Monitor
3) Select Control  Execute Viewer
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Sega Converter

     About Sega Converter   
    File Menu    
    Edit Menu

     View Menu
     Options Menu
      Window Menu

     Help Menu    

• About Sega Converter

The Sega Converter application displays 2D image data that has been saved in a variety of
file formats, and converts between formats. Displayed images can be modified using
several types of filters, and a highly refined color reduction function is provided to
convert 16M-color True Color and 32k-color High Color images using 256- and 16-color
tables.
The Converter also supports batch (catalog) handling for processing multiple files, a
feature not usually found in a GUI application.

File loading, saving and filtering in the Sega Converter are all executed through external
DLL plug-ins, so the functions are extensible by user-supplied plug-ins.

• File Menu
Provides file management, such as opening and saving files, processes such as printing,
and exiting the editor.

 New
Creates a new file.
[Dialog Box]
 Size

Enter the width (H) and height (V) of the new file.
 Color Mode

Selects the color mode for a new file. When selecting 16- or 256-color mode, also selects
the color table to be used.

 Open
Opens a previously saved file.

 Close
Closes the current file.

 Save
Saves the current file.
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 Save As
Saves the current file with a different name.

 Catalog
Setup and execute batch processing of multiple files.

Catalog Functions

 Page Layout
Set up the page layout for printing.

 Print
Prints the current file.

 1 ~ 4
Displays the last four most recently opened or saved files.

 Exit
Closes the Sega Converter.

• Edit Menu
Provides image editing functions such as cut and paste, and sets the Sega Converter
working environment.

 Undo
Cancels the most recent operation. note that not all operations can be canceled.

 Cut
Cuts the selected data to the clipboard.

 Copy
Copies the selected data to the clipboard.

 Paste
The image that has been saved on the clipboard is pasted over the current image. The
pasted image can be repositioned immediately after it is pasted (floating state).

 Delete
Erases the image in the selected area.

 Select All
Selects the whole image.

 Cancel Selection
Cancels the selection. A floating image is placed at its current location.

 Clear Clipboard
Deletes the image on the clipboard.
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 Properties
Sets up the environment for each type of editing.
[Grid]

 Units
Specifies the grid size.

 Snap To Grid
Forces selection operations to adhere to grid units.

 Color
Specifies the grid color.

[Paste]
 Dither

Applying color by extrapolation (dithering) when the paste destination is capable of
fewer colors than there are in the clipboard image.

 Ignore Palette
Ignores the color table and pastes only bitmap information.

• View Menu
Changes display magnification of the working window and selects display/non-display of
the grid.

 Magnification
Displays the current working image with the specified magnification.

 Grid
Displays/hides the specified unit grid over the current working image.
Grid units are specified from the menu by     Edit  Properties   

• Options Menu
Executes color conversion and applies various kinds of filter processing.

 Black and White
 16 colors
 256 colors
 32k colors
 16M colors

Converts the current image to the selected color mode. If the selected color mode has
fewer colors than the image before conversion, the conversion method can be specified.
[Color Table]

When converting to 16 or 256 colors, the color table can be specified for the conversion.
 Optimize

Creates an optimized color table from the color information in the current image.
 Custom

Uses a pre-registered color table.
[Dither]



52

Selects the dithering method used to display colors that are removed during conversion.
 None

Perform no dithering.
 Pattern

Apply dithering pattern.
 Error Diffusion

Apply dithering with error diffusion processing.

 Color Table
Displays the color table used for the current image when the image is 16 or 256 color.
[Dialog]

 Current
Displays the color table used for the current image.

 Custom
Displays the pre-registered color table.

 Register
Registers the displayed color table as the new table.

 Filter
Executes a plug-in function to apply filtering to the current image.

 Display
Executes a plug-in function to change the display method for the current image.

 Effect
Executes a plug-in function to apply a special effect to the current image.

 Other
Executes a plug-in function to provide another type of treatment.

Note: When an area is selected within the image, plug-in effects apply only to that area.
Otherwise, the effects apply to the whole image.

• Window Menu
Shows the types and names of currently open windows, and determines how they are
positioned.

 Cascade
Cascades windows in layers offset from the upper left.

 Tile Vertically
Displays all windows, tiled from top to bottom.

 Tile Horizontally
Displays all windows, tiled from left to right.

 Align Icons
Aligns the icons of all minimized windows.

 Close All
Closes all windows.
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• Help Menu

Display this Help window describing how to use the Sega Converter, and general
information about the Sega Converter.

 Contents
Displays the Help contents.

 About
Displays general information such as the Sega Converter version.

• Catalog Function

The Catalog function is a special feature of the Sega Converter that simplifies applying
particular processes to multiple files in a single step.
Currently supported processes are file format conversion and color reduction processing.

 Edit List
Edits the list of files to be processed by the catalog function.
[Dialog]

 Add
Adds a file to the list.

 Delete
Removes the selected file from the list.

 Refresh
Refreshes the file list based on the newest file information. When a listed file has been
moved or deleted outside of the program, refreshing the list prevents errors from
occurring with subsequent Catalog functions.

 Save
Saves the current file list.

 Open
Opens a previously saved file list. The current list is replaced by the list being loaded.

 Display
Opens files in their registered order.
[Dialog]
 Wait

Specifies a delay (in seconds) between opening files.
 Close After Display

When checked, the current window is automatically closed when a file is opened.

 Save
Saves a registered file to the list with a different name.
[Dialog]

 Auto
Sets the color mode of saved files automatically. The color mode is generally
unchanged.

 Specify



54

Specifies the color mode of saved files.
 Detail

When specifying the color mode, details can be set here. The settings are the same as
the color mode settings of the      Options Menu    .

 Color Table
Creates an optimized color table from all files registered in the list. The optimized table is
registered automatically.
[Dialog]

 Color Mode
Selects the number of colors for the table to be created.

 Caption
Enter the registration name for the color table.
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SS-SDK Plug-Ins

     About Plug-Ins

    Plug-In Functions

     Resource Files

    File I/O Modules

    Effect Modules

    Function Reference    

• Function Reference

    File       I/O          Modules   
   scvCheckFileFormat   
   scvGetFileImageSize    
   scvGetFileImageDepth    
   scvGetFileImageBits   
   scvPutFileImageBits   
   scvBeginCatalogSave    
   scvEndCatalogSave    

    Effect          Modules   
    scvEffectImageBits   
   scvBeginEffect   
   scvEndEffect   

• About Plug-Ins

The SSSDK Graphics Tool allows the addition of custom user functions using  Win32-
compliant DLLs (dynamic link libraries) for external functions.

An added function is called a "plug-in", and the DLL that provides the added function is
called a "plug-in module".

Added functions are made available by copying their plug-in modules into the same
folder as the SSSDK Graphics Tool executable.
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• Plug-In Functions
The SSSDK recognizes two types of plug-in modules for different purposes:

(1)     File       I/O          Modules   
File input and output functions.

(2)     Effects          Modules   
Apply effects such as filters to the display window.

Display Function Reference

• Resource Files
The following resources are reserved for SSSDK plug-in modules. When using

resources in a module program, be careful to avoid usage conflicts with other modules.

STRING Resources Display Sample

ID 1: Specifies a plug-in function.
File I/O

Input Only "READ"
Output Only "WRITE"
Input and Output "READ WRITE"
Effect "EFFECT"

ID 2: Specifies a 3-character alphanumeric extension for the file type used by this module.
Letters should be in lower case.
The "eff" extension denotes an Effect file.

ID 3: Specifies the name of a displayed plug-in.
For File I/O

This becomes an item in the dialog pop-up menu.
For Effect

This becomes a sub-menu of the Effect menu.

ID 4: Specifies the color depths (in bits) supported by the module. Valid values are 1, 4, 8,
16 or 24.

Example: #
STRINGTABLE DISCARDABLE
BEGIN

1 "READ WRITE"
2 "dg2"
3 "DGT2 Files"
4 "4 8 16 24"

END
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• File I/O Module

[1: Input Module]
Reads files by the following procedure and displays in the window.

(1) Select a file with the Open dialog.
(2)    scvCheckFileFormat   
(3)    scvGetFileImageSize    
(4)    scvGetFileImageDepth    
(5)    scvGetFileImageBits   
(6) Display the window.

User-created input modules need to provide functions corresponding to steps (2)
through (5) in the above procedure.

[2: Output Module]
Saves files by the following procedure.

(1) Specify a file name in the Save dialog.
(2)    scvPutFileImageBits   
(3) The file is saved.

When using the Catalog function, files are saved by the following procedure.

(1) Specify a save directory in the Save dialog.
(2)    scvBeginCatalogSave    
(3)    scvPutFileImageBits   
(4) Files are saved (by repeating step (3) for each file in the catalog list).
(5)    scvEndCatalogSave    

User-created output modules need to provide functions corresponding to steps (2), (3)
and (5) in the above procedure.

Display Function Reference

• Effect Modules

An effect is applied to the window by the following procedure.

(1) Select an item on the Effect Menu.
(2)    scvBeginEffect   
(3)    scvEffectImageBits   
(4)    scvEndEffect   
(5) Redraw the window.

User-created effect modules need to provide functions corresponding to steps (2) through
(4) in the above procedure.
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Display Function Reference

   (1-1)        •        scvCheckFileFormat      

Function:
Checks the specified file format.

Format:
BOOL WINAPI  scvCheckFileFormat(LPSTR libDLL, LPSTR filename);

Return Value:
BOOL (Format matches or not)

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename specified filename

Usage:
Opens the file, and then closes it after checking the format.
Returns TRUE when the specified format matches, or FALSE if it does not match.

   (1-2)        •        scvGetFileImageSize

Function:
Reads the vertical and horizontal size of a specified file.

Format:
void WINAPI  scvGetFileImageSize(LPSTR libDLL, LPSTR filename, LPSTR hsize,
LPSTR vsize);

Return Value:
none

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename specified filename
LPSTR hsize pointer to horizontal size of image
LPSTR vsize pointer to vertical size of image

Usage:
Opens the file, and then closes it after getting the dimensions.
Sets the long value pointed to by hsize to the horizontal size.
Sets the long value pointed to by vsize to the vertical size.
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   (1-3)        •        scvGetFileImageDepth    

Function:
Reads the color depth of the specified file.

Format:
long WINAPI  scvGetFileImageDepth(LPSTR libDLL, LPSTR filename);

Return Value:
long ColorDepth

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename specified filename

Usage:
Opens the file, and then closes it after getting the color depth.
ColorDepth (in bits) is returned as 1, 4, 8, 16 or 24 (32).

   (1-4)        •        scvGetFileImageBits    

Function:
Reads the bitmap from the specified file.

Format:
int WINAPI  scvGetFileImageBits(LPSTR libDLL, LPSTR filename, LPSTR buff);

Return Values:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename specified filename
LPSTR buff bitmap buffer

Usage:
Opens the file and reads the bitmap data into memory.
Closes the file and returns 0 for normal finish.
Returns non zero when an error occurs before completion.

Remarks:
The     Bitmap Memory     Bitmap Memory is stored as an array of horizontal size  vertical

size  color depth (bits), but the format varies slightly according to the color depth.
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   (2-1)        •        scvPutFileImageBits    

Function:
Saves a bitmap to the specified file.

Format:
int WINAPI  scvPutFileImageBits(LPSTR libDLL, LPSTR filename, LPSTR buff, LPSTR hs,
LPSTR vs, LPSTR depth);

Return Value:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename specified filename
LPSTR buff bitmap buffer (memory)
LPSTR hs pointer to horizontal size of image
LPSTR vs pointer to vertical size of image
LPSTR depth pointer to color depth of image

Usage:
Pointers hs, vs and depth point to the respective values cast to long.
Opens the file and writes the information from the bitmap buffer.
Closes the file and returns 0 for normal finish.
Returns non zero when an error occurs before completion.

Remarks:
The     Bitmap Memory     Bitmap Memory is stored as an array of horizontal size  vertical

size  color depth (bits), but the format varies slightly according to the color depth.

   (2-2)        •        scvBeginCatalogSave    

Function:
To be called before the catalog save loop is executed.

Format:
int WINAPI  scvBeginCatalogSave(LPSTR libDLL, LPSTR filename, LPSTR num);

Return Value:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename String (filename) entered by the Save dialog
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LPSTR num Pointer to catalog number

Usage:
Normally returns zero.
Use to save catalog data in one file.

   (2-3)        •        scvEndCatalogSave    

Function:
Called after the catalog save loop has been executed.

Format:
int WINAPI  scvEndCatalogSave(LPSTR libDLL, LPSTR filename);

Return Value:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR filename String (filename) entered by the Save dialog

Usage:
Normally returns zero.

   (3-1)        •        scvEffectImageBits    

Function:
Applies an effect to a bitmap.

Format:
int WINAPI  scvEffectImageBits(LPSTR libDLL, LPSTR buff, LPSTR hs, LPSTR vs, LPSTR
depth)

Return Value:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle
LPSTR buff bitmap buffer
LPSTR hs pointer to image horizontal size
LPSTR vs pointer to image vertical size
LPSTR depth pointer to image color depth



62

Usage:
Pointers hs, vs and depth point to the respective values cast to long.
The effect is applied to the bitmap buffer.
Returns 0 for normal finish.
Returns non zero when an error occurs before completion.

Remarks:
The     Bitmap Memory    Bitmap Memory is stored as an array of horizontal size  vertical size

color depth (bits), but the format varies slightly according to the color depth.

   (3-2)        •        scvBegineEffect   

Function:
To be called before applying an effect.

Format:
int WINAPI  scvBeginEffect(LPSTR libDLL);

Return Value:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle

Usage:
Normally returns zero.

   (3-3)        •        scvEndEffect   

Function:
To be called after an effect has been applied.

Format:
int WINAPI  scvEndEffect(LPSTR libDLL);

Return Value:
Successful completion 0
Error non zero

Calling Arguments:
LPSTR libDLL DLL instance handle

Usage:
Normally returns zero.
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• Bitmap Memory
Color depth: 1

The bitmap is structured as 1 bit/pixel.
The horizontal size is limited to a 1-byte boundary.
1 = black, 0 = white.

Color depth: 4
16 color array structure
The RGBQUAD structure body is configured for 16 colors.
The bitmap is structured as 4 bits/pixel.
The horizontal size is limited to a 1-byte boundary.

Color depth: 8
256 color array structure
The RGBQUAD structure body is configured for 256 colors.
The bitmap is structured as 8 bits/pixel.

Color depth: 16
Direct color system.
The bitmap is structured as 16 bits/pixel, with each color stored in the form 0b|R5|G5|B5.

Color depth: 24 (32)
Direct color system.
The bitmap is structured as 32 bits/pixel, with each color stored in the form 8b|R8|G8|B8.

• Hierarchy Structure - Tools Menu
Controls display or non-display of the structure of the currently selected hierarchy. Also
allows editing the model name.

 Display
Displays the structure of the currently selected hierarchy. When a structure tree is
inherited, applies to all models in classes beneath the current model.

 Hide
Hides the structure of the currently selected hierarchy. When a structure tree is inherited,
applies to all models in classes beneath the current model.

 Change Name
Changes the model name in the structure of the currently selected hierarchy. When saved
in MDL format, notice that the name specified here is changed.

    3D Editor File Formats   

 Hierarchy Info
Displays the matrix information of the currently selected hierarchy.

 Close
Closes the Hierarchy Structure window.

-end 1996.11.05
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